Lesson 9

Analyze Financial Data
Copyright

Copyright 2018 Intuit, Inc. All rights reserved.
Intuit, Inc.
5601 Headquarters Drive
Plano, TX 75024

Trademarks

©2018 Intuit, Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte, ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered trademarks of Intuit, Inc. in the United States and other countries. Other parties’ marks are the property of their respective owners.

Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting professionals in their practices by providing current and accurate information. However, no assurance is given that the information is comprehensive in its coverage or that it is suitable in dealing with a client’s particular situation. Accordingly, the information provided should not be relied upon as a substitute for independent research. Intuit, Inc. does not render any accounting, legal or other professional advice, nor does it have any responsibility for updating or revising any information presented herein. Intuit, Inc. cannot warrant that the material contained herein will continue to be accurate nor that it is completely free of errors when published. Readers should verify statements before relying on them.
# Table of Contents

About the Author .................................................................................................................. 4
Lesson Objectives .................................................................................................................. 5
Create QuickReports ............................................................................................................ 6
Zoom in on a QuickReport ...................................................................................................... 8
Customize QuickReports ...................................................................................................... 9
Use the Report Center ........................................................................................................... 12
Create a Balance Sheet Previous Year Comparison Report .................................................. 14
Filter Reports ....................................................................................................................... 16
Save Reports as PDFs ............................................................................................................ 19
Use QuickZoom in a Report .................................................................................................. 20
Memorize Reports ................................................................................................................ 22
Create Memorized Report Groups ......................................................................................... 24
Print Reports ......................................................................................................................... 25
Process Reports in Groups .................................................................................................... 26
Process Multiple Miscellaneous Reports ................................................................................ 27
Send a Report to Excel .......................................................................................................... 28
Create an Income and Expense Graph .................................................................................. 30
Use QuickZoom with Graphs ............................................................................................... 32
Customize How Graphs Display ........................................................................................... 33
Analyze Financial Data – Review Questions ........................................................................ 35
Review Activities .................................................................................................................. 36
Answers to Review Questions .............................................................................................. 37
About the Author

Esther Friedberg Karp, MBA
President, EFK CompuBooks Inc.

Esther Friedberg Karp is an internationally-renowned trainer, writer, business consultant and speaker who was named one of the Top 10 QuickBooks ProAdvisors in the world, with the title Top International ProAdvisor.

Based in Toronto, Canada, Esther has the unique distinction of holding ProAdvisor certifications in the United States, Canada and the United Kingdom. She has authored materials and delivered educational and certification courses for Intuit in all those countries, as well as Australia where she conducted live QuickBooks Online training. She has spoken at Scaling New Heights, QuickBooks Connect and other conferences, as well as those of various accounting and professional organizations and written countless articles for Intuit Global.

Esther counts among her clients’ companies from around the world, as well as accounting professionals who seek her out on behalf of their own clients for her expertise in various countries’ editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for different industries.

Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA in Marketing and Finance from York University’s Schulich School of Business.

She can be reached at esther@e-compubooks.com or 416-410-0750.
Lesson Objectives

- Discuss some of the tools in QuickBooks for analyzing financial data: QuickReports, preset reports and graphs
- Create a QuickReport
- Add a column to a report
- Learn how to move a column in a report
- Learn about the types of preset reports QuickBooks offers
- Practice creating reports and viewing them onscreen
- Customize a report by changing how it looks and the data it covers (filtering)
- Learn how to process reports in batches
- Save reports as portable document format (PDF) files
- Learn how to export a report to Microsoft Excel®
- Practice filtering reports in Excel
- Learn about the types of graphs QuickBooks offers
- Create and customize several graphs
Create QuickReports

One of the fastest ways to see a report on your QuickBooks data is to create a QuickReport. QuickReports are predesigned reports that give you information about the list name you’re currently viewing on screen. Whenever you have a list, register or form displayed, you can click a button to have QuickBooks create a QuickReport.

**Step-by-Step: See What You Owe a Vendor**

1. Click **Vendor Center** on the icon bar.
2. Right-click on the vendor name you wish to run a report for and select **QuickReport**, or click on the **QuickReport** hyperlink in the section.

![QuickReport Window](image)

3. You can expand the date range to capture more transactions on your QuickReport. You’ll see other ways to customize the QuickReport later in this lesson.
Zoom in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better understand the information presented in reports, QuickBooks lets you trace report data to the individual transaction level using QuickZoom.

When you position the mouse pointer over a number in a report and see the QuickZoom symbol (a magnifying glass with a Z in it), you can double-click the number to display the original transaction in QuickBooks.

Step-by-Step: See more Detail about a Transaction

1. From any financial report, hold your cursor over the dollar amount/transaction you wish to view in more detail.

2. When your cursor turns into the QuickZoom icon, double-click your mouse to zoom in. This will open the transaction.

3. Press Esc to close the window.

NOTES
Customize QuickReports

Each QuickReport window has a button bar at the top of the report for customizing report content and layout.

Step-by-Step: Add a Column to a Report

1. In the QuickReport window, click Customize Report.

2. In the Columns list, select the additional columns you would like to add to the report (in this example, we marked the Trans # column).
3. Click **OK** to accept the change.

Notice the additional column(s) in your report.

**Step-by-Step: Move a Report Column**

1. Position your mouse pointer over the column you wish to move (the mouse becomes a hand).

2. Hold down the **left mouse button** and drag the column header/name to the position you would prefer. When a red arrow appears, release your mouse button if you want the column to appear in this new position.
**Step-by-Step: Change Information in the Report Heading**

1. In the report window, click **Customize Report** then click the **Header/Footer** tab.

![Modify Report: Vendor QuickReport](image)

On the **Header/Footer** tab you can change the company name, report title, subtitle, and date and time prepared. You can also specify whether to print the header on all pages or just the first page. The Header/Footer tab is the same for all QuickBooks reports.

2. Highlight the text in the Report Title field and replace it with the title you would like.

3. Click **OK** to close the Modify Report window.

4. Close the report.

**IMPORTANT:** To save this report for future use, click the **Memorize** button on the report tool bar before closing the report. This allows you to save the custom settings and run the report with the new settings at a later date from the **Reports** drop-down menu.

**NOTES**
Use the Report Center

A good way to learn about the reports available in QuickBooks – and how to work with them – is the Report Center.

The Report Center contains a description and example of each QuickBooks report. You can click the icons at the top right corner of the Report Center to select the display format you prefer.

**Step-by-Step: Learn More about Reports**

1. Click **Reports** on the icon bar (or under the Reports menu), and then click **Report Center**.
2. Use the blue view icons in the top right corner to customize your view.
3. Click the **Contributed** tab to open Contributed Reports, an Intuit web page where you can search, review, download and import additional reports. Review the information, and then close the window.
Create a Balance Sheet Previous Year Comparison Report

The balance sheet comparison report compares the current year against the previous year in both dollar amount and percentage.

Step-by-Step: Create a Balance Sheet Previous Year Comparison Report

1. In the Report Center, click on the Standard tab and choose Company & Financial, scroll down and choose Balance Sheet Prev Year Comparison.

2. Click the Run icon.

Scroll the report window to see more of the report.
3. Click the **Collapse** button in the top right section of the report to see the difference.

   The Collapse button hides subaccounts, jobs and subclasses. Amounts are summarized under the parent account. This button affects both the onscreen and printed report.

4. Click **Expand** in the top right section of the report (where the Collapse button had been) to return to the original report display.

5. Close the report.

**NOTES**
Filter Reports

You can customize reports in QuickBooks to highlight just the information you’re interested in getting. In this exercise, you’ll customize the balance sheet comparison report and filter it to include only the transactions you specify.

Report filters let you set custom criteria for the transactions you want included in a report. When you filter a report, QuickBooks includes only those transactions that match the rules you create.

**Step-by-Step: Filter a Preset Report**

2. Click the *Filters* tab.
3. In the Filter scroll box, choose the filters for which you want to set your parameters and set your specifications.
4. To remove or modify a filter, highlight it in the Current Filter Choices section, and either modify the filter or click **Remove Selected Filter**.

5. Click **OK**.

6. You can review what filters have been applied directly on any particular report by clicking **Show Filters** in the top left corner of the displayed report. Once you have done that, you can click on a filter to change it, or click on the **X** next to the filter to remove it. When printed, reports with Applied Filters displayed will print the filters on a separate page. You can also click **Hide Filters** (where the Show Filters button had been) to hide the list of filters.
### Balance Sheet: Prev Year Comparison

**As of December 15, 2022**

<table>
<thead>
<tr>
<th>Category</th>
<th>Dec 15, 22</th>
<th>Dec 16, 21</th>
<th>$ Change</th>
<th>% Change</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ASSETS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Assets</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checking/Savings</td>
<td>44,799.10</td>
<td>36,865.57</td>
<td>7,933.53</td>
<td>21.5%</td>
</tr>
<tr>
<td>10100 - Checking</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10300 - Savings</td>
<td>17,910.19</td>
<td>15,808.64</td>
<td>2,101.55</td>
<td>13.3%</td>
</tr>
<tr>
<td>10400 - Petty Cash</td>
<td>500.00</td>
<td>500.00</td>
<td>0.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Total Checking/Savings</td>
<td>63,209.29</td>
<td>53,165.21</td>
<td>10,044.08</td>
<td>18.9%</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>93,007.93</td>
<td>20,041.04</td>
<td>72,966.89</td>
<td>349.3%</td>
</tr>
<tr>
<td>11000 - Accounts Receivable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Accounts Receivable</td>
<td>93,007.93</td>
<td>20,041.04</td>
<td>72,966.89</td>
<td>349.3%</td>
</tr>
<tr>
<td>Other Current Assets</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12000 - Undeposited Funds</td>
<td>2,440.00</td>
<td>20,252.00</td>
<td>-17,812.00</td>
<td>-88.0%</td>
</tr>
<tr>
<td>12100 - Inventory Asset</td>
<td>30,882.38</td>
<td>12,767.04</td>
<td>18,115.34</td>
<td>144.3%</td>
</tr>
<tr>
<td>12800 - Employee Advances</td>
<td>832.00</td>
<td>770.00</td>
<td>62.00</td>
<td>8.1%</td>
</tr>
<tr>
<td>13100 - Pre-paid Insurance</td>
<td>4,050.00</td>
<td>5,051.85</td>
<td>-1,001.85</td>
<td>-20.0%</td>
</tr>
<tr>
<td>13400 - Retainage Receivable</td>
<td>3,703.02</td>
<td>1,798.72</td>
<td>1,904.30</td>
<td>108.1%</td>
</tr>
<tr>
<td>Total Other Current Assets</td>
<td>41,708.40</td>
<td>40,677.80</td>
<td>1,030.60</td>
<td>2.5%</td>
</tr>
<tr>
<td>Total Current Assets</td>
<td>197,928.82</td>
<td>114,697.04</td>
<td>83,231.78</td>
<td>72.8%</td>
</tr>
<tr>
<td><strong>Fixed Assets</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15000 - Furniture and Equipment</td>
<td>34,328.00</td>
<td>22,838.00</td>
<td>11,490.00</td>
<td>50.4%</td>
</tr>
</tbody>
</table>
Save Reports as PDFs

To keep a record of the information in the report as it exists today, you can save the report in portable document format (PDF).

**Step-by-Step: Save a Report as a PDF File**

1. With the report open, choose **Save as PDF** from the File menu. (You can also click on **Print → Save as PDF**.)

2. Navigate to the folder where you want to store the PDF and enter a file name.

3. Click **Save**.

4. Close the report window.

**IMPORTANT:** if you wish to send the report as a PDF attachment to an email in one step without saving it as a PDF first, select **Email → Send report as PDF**. (QuickBooks will not allow you to select the Send report as PDF option if you are using a sample company.)

**NOTES**
Use QuickZoom in a Report

**Step-by-Step: QuickZoom on a Listing in a Report**

1. Position the mouse pointer over the listing you wish to view in detail.
2. Double-click the amount.

   What you see when you QuickZoom in a report will depend on the type of report displayed:

   - If the report shows summary figures (like the Sales by Customer Summary report below) and you QuickZoom an amount...
... QuickBooks displays a detail report that includes the transactions which contribute to that amount. You can then double-click on an individual transaction in that detail report to QuickZoom on it.

- If you QuickZoom a transaction in a detail report, QuickBooks opens and displays the invoice, bill or other form for the requested transaction. At this point you can review, delete or edit the displayed transaction as necessary.

**NOTES**
Memorize Reports

You may want to memorize reports which you customize, filter and run frequently. Memorizing reports can save you from spending time customizing the same reports over and over again. *Remember, memorizing reports saves your customizations and filters, not the data.* As new data is entered or existing data is changed, running a memorized report will display the refreshed data but with the same settings (e.g., columns, title, etc.) you saved.

**Step-by-Step: Memorize a Report**

1. When you are in a report you would like to memorize, click Memorize from the report tool bar.

2. Name the memorized report accordingly.

3. Click the **Save in Memorized Report Group** checkbox if you would like to assign this report to a group (you’ll see more about memorized report groups in the next section), then choose the group from the drop-down menu.

4. Check the box next to **Share this report template with others** if you wish to offer this memorized report (the settings, not the data!) to the entire Intuit community to help others who may have a need for business information similar to yours in their own QuickBooks company files.
5. Click **OK** to memorize the report.
6. Close the report.

**NOTES**
Create Memorized Report Groups

In addition to memorizing individual reports to save report settings, you can create memorized report groups to organize your memorized reports in a way that makes sense for your business and allows you to process a group of reports all at once.

QuickBooks comes preset with a number of memorized report groups, each already populated with common reports for each area. You can add your own reports to these groups, modify the groups to meet your needs and even create your own groups.

**Step-by-Step: Create a Memorized Report Group**

1. Choose **Memorized Reports** from the Reports menu then choose **Memorized Report List.**

![Memorized Report List]

2. In the Memorized Report List, click the **Memorized Report** menu button, and then choose **New Group.**

3. In the Name field of the New Memorized Report Group window, type **Year End.**

4. Click **OK.**
Print Reports

Step-by-Step: Print a Report

1. With a report open, click the Print button from the tool bar then choose Report.

2. Click Preview to see how the report will look when you print it.

   QuickBooks displays a preview of your report onscreen.

3. Click Print.

4. Close the report.

NOTES
Process Reports in Groups

Step-by-Step: Batch Process Reports in a Group

1. In the Memorized Report List, select the report group you would like to print.

2. Click Display.

QuickBooks opens the Process Multiple Reports window. You can use this window to display or print the selected reports (selected by the checkmark in the far left column next to the reports). You can also change the date range for reports in this window before you display or print them by changing the information in the From or To columns.

3. Select the reports you wish to print and click Display to review the information in the reports, or click Print to print the reports.

If you chose to display the reports, you can print each report individually. Click the Print button from that report’s tool bar, and then choose Report.

Notes
Process Multiple Miscellaneous Reports

In addition to batch processing a group of reports, you can also batch process various selected memorized reports that are not all in the same report group.

Step-by-Step: Batch Process Multiple Miscellaneous Reports

1. From the Reports menu, select **Process Multiple Reports**.

2. QuickBooks opens the Process Multiple Reports window. Select the memorized reports you want to process (all reports from all groups are currently listed) by placing a checkmark next to the desired reports. You can also change the date range for reports in this window before you display or print them by changing the information in the From or To columns.

3. Once the desired reports are selected, choose **Display** to review the information in the reports or **Print** to print the reports.

   If you chose to display the reports, you can print each report individually. Clicking the **Print** button from that report’s tool bar, and then choose **Report**.
Send a Report to Excel

Occasionally you may want to change a report’s appearance or contents in ways that aren’t available in QuickBooks, filter report data in ways you can’t in QuickBooks, or run “what-if” scenarios on your QuickBooks data.

You can send reports from QuickBooks to Excel. Since the changes you make in Excel don’t affect your QuickBooks data, you’re free to customize reports as needed and even change data to run “what-if” scenarios.

Step-by-Step: Send a Report to Excel

1. From the Reports menu, open the report you would like to convert to Excel.
2. On the Report button bar at the top of the report, set the date parameters for your report. You can use the Customize button to set additional filters and add additional customization.
3. If you clicked on the Customize button in the previous step, after you’ve specified your additional parameters, click OK.
4. On the Report button bar, click Excel and Create New Worksheet (or you could select Update Existing Worksheet if this report with these settings was previously sent to a spreadsheet that was saved).
5. Click the **Advanced** tab to add custom export options of **Auto Outline** and **Auto Filtering** if they’re not chosen already.

![Advanced Excel Options](image)

6. Click **OK**, and then click **Export**.
Create an Income and Expense Graph

If you want your business to be profitable, you need to keep an eye on your expenses. The income and expense graph shows exactly what you’re spending and where.

You should be especially concerned with the proportion you’re spending on expenses relative to the income you receive. As a simplistic example, if you’re earning only $20,000 in income, you don’t want to spend $30,000 in expenses.

**Step-by-Step: Create an Income and Expense Graph**

1. From the Reports menu, choose **Company & Financial** then choose **Income & Expense Graph**. You will see the top 10 expense categories listed with numerical information next to a key listing them with their pie chart colors.

![Income and Expense Graph](image)

2. You can choose to categorize expenses **By Account**, **By Customer** or **By Class** from the report tool bar at the top.

![Expense Summary](image)
3. QuickBooks can display information on only 10 pie segments at a time. To display more accounts, click the **Next Group** button at the top of the graph window.

4. You can change the date range by clicking on the **Dates** button at the top.

**Step-by-Step: Display Income Accounts Instead of Expense Accounts**

1. Click **Income** at the bottom of the graph window.

2. Choose to categorize income By Account, By Customer or By Class from the report tool bar at the top.
Use QuickZoom with Graphs

To help you better understand the information shown in the graphs, QuickBooks lets you trace graphical data using QuickZoom. This works the same as the QuickZoom functionality on report entries described earlier in this lesson.

**Step-by-Step: QuickZoom on Graphical Information**

1. Position the mouse pointer over the section of the chart you wish to see in more detail and double-click.

**IMPORTANT:** The QuickZoom report features will vary depending on the type of information you are choosing to QuickZoom in order to get more details.
Customize How Graphs Display

You can customize graphs to control what data they include and how the data is displayed. In this exercise you’ll change the display from three-dimensional (3D) to two-dimensional (2D) graphs.

**Step-by-Step: Change from 3D to 2D**

1. From the Edit menu, choose **Preferences**.
2. In the left panel, click **Reports & Graphs**.
3. In the My Preferences tab, place a checkmark in the box next to **Draw graphs in 2D (faster)**.

4. Click **OK**.
5. Open the **Report Center**.
6. Choose Sales then Sales Graph to view the effect of the change.

7. Click the Run (Display Report) icon.

8. Close the graph.


**NOTES**
Analyse Financial Data – Review Questions

1. ________________ is the tool that allows you to drill down on summary reports and graphs in QuickBooks.

2. When can you generate a QuickReport?
   a. Only when viewing an active customer or account
   b. Only when viewing a list, register or form
   c. Only at the end of the current fiscal period
   d. Only when viewing balance sheet accounts

3. In which report category would you find a list of open invoices?
   a. Company & Financial
   b. Sales
   c. Customers & Receivables
   d. List

4. Report ________________ let you set custom criteria for the transactions you want to include in a report.

5. Once you’ve customized a preset report to meet your needs, how can you save your settings so you don’t have to customize the report each time you run it?
   a. Choose **Save Settings** from the Report menu
   b. Choose **Save Setting** from the File menu
   c. Click **Memorize** on the button bar
   d. Click **Modify** then choose **Memorize**

6. True or false: Once you’ve exported report data to Excel, you can send modified data back to QuickBooks.
   a. True
   b. False
Review Activities

1. Create a QuickReport on a name in one of Rock Castle Construction’s lists.

2. Rock Castle Construction wants to create a report that shows how much they have spent on lumber for projects during November of the current year (the current year is whatever Rock Castle Construction specifies is the current year based on the date you see when you open that sample company). Create an item summary purchase report covering the date range for November of the current year. Filter the report to show only Rock Castle Construction’s purchases for lumber.


4. Use the Report Center to find reports that show the following:
   - Sick and vacation balances for each employee
   - Time spent on each job
   - Inventory stock on hand and reorder point
   - Customers with overdue payments, how much they owe and their phone numbers
   - How much of total sales is taxable, at what rate, and how much sales tax is currently due to be paid
Answers to Review Questions

1. *QuickZoom* is the tool that allows you to drill down on summary reports and graphs in QuickBooks.

2. When can you generate a QuickReport?
   a. Only when viewing an active customer or account
   b. ✓ Only when viewing a list, register or form
   c. Only at the end of the current fiscal period
   d. Only when viewing balance sheet accounts

3. In which report category would you find a list of open invoices?
   a. Company & Financial
   b. Sales
   c. ✓ Customers & Receivables
   d. List

4. Report filters let you set custom criteria for the transactions you want to include in a report.

5. Once you’ve customized a preset report to meet your needs, how can you save your settings so you don’t have to customize the report each time you run it?
   a. Choose Save Settings from the Report menu
   b. Choose Save Setting from the File menu
   c. ✓ Click Memorize on the button bar
   d. Click Modify then choose Memorize

6. True or false: Once you’ve exported report data to Excel, you can send modified data back to QuickBooks.
   a. True
   b. ✓ False